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Preface 
 

The optics required for photoelasticity is simple and hence easy to establish and it has the 

advantage of providing whole field information of the stress field. Photoelasticity basically provides 

contours of principal stress/strain difference (isochromatic fringes) and principal stress/strain 

direction (isoclinic fringes). Several problems could be studied just by observing the whole field 

nature of the fringe field. Fringe density is a useful tool to identify zones of stress concentration and 

also zones where material needs to be removed for reducing the weight! For quantitative data 

deduction, one needs to get the isochromatic and isoclinic value at that point. Ordering of the fringes 

is to be learnt for any experimental technique. One of the simplest ways to do this is to see the 

typical fringe patterns for a variety of problems. 

 

P_Scope
®
 is an innovative software that simulates the conventional polariscope using Jones 

calculus for ten different problems for which theory of elasticity solution exists. It is a unique software 

that can help to learn conventional photoelasticity as well as digital photoelasticity. In addition, it is 

also a very useful tool to learn nuances of stress analysis. The software is designed in such a way 

that the parameters governing the problems can be changed by the user to customize the simulation 

for their situations. At any point in time the user can revert back to default values conveniently. In 

addition for each parameter a range has been set and if the entered value is not within the range it 

alerts the user by colouring the value in red and a pop-up window shows the suggested range. 

Please note that this feature is only a facility, and the user is expected to enter realistic values to see 

realistic fringe patterns. 

 

One can simulate the plane and Circular Polariscopes using monochromatic light. One has the 

flexibility to choose a variety of light sources as well as model materials for their simulation. As 

Jones calculus is used, for any point in the field of view one can trace the polarization state of the 

incident light after each optical element. The wave plots thus generated for the point of interest can 

also be saved. Thus one can develop an in-depth knowledge of the photoelastic theory. As the 

stress information is theoretically calculated, the software provides the stress tensor at the point of 

interest, maximum shear stress, principal stresses and their associated directions. Links to relevant 

video lectures are also provided. The various problems are labeled as in Theory of elasticity (for 

example thick cylinder is labeled as the Lame’s problem) and the software can be innovatively used 

by a teacher even for a course on Theory of Elasticity. For example, the stress information does not 

change in plane problems, if the load is kept constant and the material is changed. On the other 

hand change of load or material does not change the orientation of principal stress directions for a 

given model shape. The software can also be used to specify the nature of residual stress field 

produced in a drilling operation, stress field under Hertzian and non-Hertzian contact, stress 

intensification due to a crack etc. – these are subtle concepts that can be taught effectively. 

 

A special pop-up menu is designed, that has two sub menus one to show fringe patterns/phase 

maps and the other to show stress component plots. Using the fringe patterns menu one can show 

for the problem selected, various fringe fields if white light is used. This can be advantageously used 

to learn fringe ordering using a colour code. It also displays what would be the nature of isopachics 

(contours of sum of principal stresses) for the problem on hand as well as a special composite 
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display of all isoclinics. The all isoclinic field also shows whether a particular isoclinic displayed is the 

major or the minor principal stress direction. This is a valuable information, which has not been given 

much importance in general stress analysis.  

These Popup menus also have a provision to plot data along lines or user specified contours as well 

as exports these data to an Excel file. 

 

The software also has a feature to zoom the entire image or around selected points to minutely 

investigate the special features of the fringe patterns. The main window and pop-up menus are 

interconnected so that the pop-up menu displays the respective images with the same zoom for 

easy comparisons. This feature is advantageous to learn the various fringe features of both 

isochromatic and isoclinic fringe fields and their interconnections. The pop-up menus can be 

conveniently minimized to clear field of view. 

 

As the software simulates, based on Theory of Elasticity solution, it also provides the theoretical 

values of fringe order and isoclinic value as recorded in a conventional polariscope. This feature 

helps to learn fringe ordering and also to effect compensation quickly at the point of interest. The 

software has three modes of compensation: Babinet-Soleil, Tardy-manual and Tardy-auto. The 

fringe fields are realistically simulated using Jones calculus and the student can understand the 

importance of first finding the isoclinic angle at the point of interest and also the heuristic information 

that is extracted from the fringe fields for data interpretation. This knowledge can help one to 

appreciate the intricacies in the development of Digital Photoelasticity. 

 

Use of carrier fringes has been used in various experimental methods to augment the fringe field 

information. The software also has a feature to introduce carrier fringes of various densities at 

various angles to any of the selected models. A simple wedge type carrier is introduced by the 

simulation, whose parameters are selectable by the user. Use of carrier fringes has been found to be 

convenient for extracting data from poor birefringent materials like glass. 

 

With advancements in digital imaging hardware, use of intensity information for data processing has 

come to stay and a new branch of Digital Photoelasticity has emerged and has stabilized in the last 

three decades. The information of both isochromatic and isoclinic fringe order at every point in the 

domain can be easily determined by processing intensity data from multiple acquisitions. If one uses 

white light photoelasticity, conventional optical arrangements are sufficient for digital data 

processing. Isochromatics up to twelve fringes in the field can be easily obtained by just recording 

only the dark field isochromatics in a conventional Circular Polariscope. However, if isoclinics are 

required over the field, four Plane Polariscope images recorded in colour having 0°, 22.5°, 45° and 

67.5° isoclinics are required. Isochromatics with highest accuracy is possible if additional six images 

are recorded in a Circular Polariscope using a monochromatic source. 

 

By processing the intensity data one essentially gets raw data in the form of phasemaps. P_Scope
®
 

has a facility to plot the typical phasemaps for a variety of problems. One can understand the 

existence of inconsistent zones in isoclinic phasemaps and ambiguous zones in isochromatic 

phasemaps. Thus P_Scope
®
 not only trains the student in conventional polarisciope, it also equips 
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the student to understand the nuances of digital photoelasticity and such a background would help to 

use the software like DigiTFP
®
 for processing real experimental data with confidence. 

 

Whole field appreciation of stress components is possible through the use of stress component plots 

pop-up menu. It can plot stress components as simple contour plots and also as pseudo fringe 

contours. Unlike in photoelasticity, the pseudo fringe contours can have negative fringe orders. The 

shape of the contour is easily noticed by plotting the pseudo fringe contours. The maximum and 

minimum values of the contour plots need to be selected suitably by the user as they are problem 

dependent. This menu also plots the contours of vonMises stress as that is what one can plot from a 

standard Finite Element Software. In some instances these plots would be very similar to the 

photoelastic contours. 
 

Photoelasticity has played a significant role in phenomenological understanding of complex 

situations like crack propagation, crack-stress wave interactions, granular materials, and motility of 

organisms etc. It has been applied to analysis of cutting tools, masonry structures, polymers, glass, 

aerospace components, silicon wafers and biomechanics thus spanning several engineering 

disciplines. 
 

This manual has eleven different experiments in a graded fashion illustrating and training on various 

aspects of P_Scope
®
.  For the first nine exercises, for each experiment, ten variations are provided 

so that ten different situations can be easily set for each experiment. The tenth exercise deals with 

whole field visualization of stress fields as well as variation of the specific components along lines or 

user specified contours. Many possibilities for constructing specific tasks for each of the problems 

that can be simulated by P_Scope
®
 are indicated. The list is not exhaustive and the user/teacher can 

construct many such exercises to suit their specific requirement. The last experiment deals with 

post-processing the Finite Elements results from a commercial package like ABAQUS to plot 

photoelastic fringe patterns in colour for ease of experimental comparisons.  
 

A brief bibliography is provided at the end to give a glimpse of variety of applications for which 

photoelasticity can be used. Photoelasticity has played a significant role in phenomenological 

understanding of complex situations like crack propagation, crack-stress wave interactions, granular 

materials, and motility of organisms etc. It has been applied to analysis of cutting tools, masonry 

structures, polymers, glass, aerospace components, silicon wafers and biomechanics thus spanning 

several engineering disciplines. 
 

My doctoral students Vivekanandan, Hariprasad and Subramanyam Reddy have enthusiastically 

participated in the preparation of this booklet. My special thanks are to these students and also to 

Mrs. Ramya Chandrasekaran, Project Officer and Vivekanandan, my doctoral student for improving 

the GUI of the software and introducing several other features for its effective usage. This software 

had a long journey, started as a term paper at IIT Kanpur 28 years back! Developed and improved 

by a large number of students and Project associates over the years. My thanks to all those who 

have contributed. 

 

Prof. K. Ramesh 

January 2017 
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1. Introduction to P_Scope® 

 

1. Objective  

(i) To understand how to open a problem and set up a virtual Plane Polariscope, Circular 

Polariscope dark and bright fields. (ii) To look and appreciate the colour isochromatics and isoclinics 

using the Pop-up Menu.  

2. Procedure 

The P_Scope
®
 software is used to simulate the fringe patterns namely the isochromatics (contours 

of constant principal stress difference) and isoclinics (contours of constant principal stress directions) 

under different arrangements of the polariscope. The two common arrangements are the plane and 

Circular Polariscopes. In addition, the software has the capability to alter the orientation of the optical 

elements selected by the user. This feature is provided to look at the optical configurations used in 

digital photoelasticity. To view a model in different polariscope arrangements, one can follow the 

steps mentioned next. 

2.1. Opening the software 

1. Open the P_Scope
®
 software. Double click    icon in the desktop. 

2. The main window of the software is shown in Fig. 1.1. 

 

3. First, the user has to choose a model to be used in the polariscope arrangement.  Click 

Model in the main menu and choose Disc from the dropdown menu (Fig 1.2). 

Fig. 1.1 The main window of the software 
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4. A circular disc model in a default polariscope arrangement (Circular Polariscope, dark field, 

epoxy as the model material and sodium vapour as the light source) appears. 

5. The left side of the main window shows the plot (Fig 1.3a) of fringe patterns obtained by Jones 

Calculus. 

 

6. The figure in the top right corner of the window (Fig 1.3b) is the light wave representation which 

shows the state of polarisation of the light after each optical element in the polariscope. 

7.  The figure in the bottom right corner is the front projection of the light vector at the top. 

8. To change the optical arrangement or to change the model material or light source, click setup. 

(a) 

Fig. 1.3 (a) Isochromatic fringe pattern (b) Light wave representation  

(b) 

Fig. 1.2 Model and Setup  

Menus 
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2.2. Plane Polariscope 

1. Select Plane Polariscope from the Setup dropdown menu. 

2.  A dialog box to setup Plane Polariscope pops up (Fig. 1.4a). 

3. In the Plane Polariscope dialog box, one can choose a dark field arrangement or a generic 

arrangement.  In conventional photoelasticity only dark field is valid. 

4.  The default isoclinic value is set as 0
o
. To view any isoclinic put the desired isoclinic value. 

5.  The isoclinics are named based on the analyser angle. For example, if the analyzer is at an 

angle of 10
o
 from the horizontal axis, the corresponding isoclinic is called a 10

o
 isoclinic. It is to 

be noted that in a dark field polariscope, polariser and analyser are always crossed.   

6.  Check the Dark Field radio button and click Apply. 

7.  In the plot area, one can see the simulated plot of isochromatics with 0
o
 isoclinic for a circular 

disc under diametral compression.    

 

2.3. Circular Polariscope 

1. Click the Setup menu and choose Circular Polariscope.  The dialog box (Fig. 1.4b) for Circular 

Polariscope pops up. 

2. In a Circular Polariscope arrangement, the isoclinic fringe patterns are eliminated and one can 

view only the isochromatic fringe patterns.  A Circular Polariscope has two additional elements 

called quarter wave plates. 

3. Here one has the option to choose a dark field, bright field or a generic arrangement. 

  

(a) 

Fig. 1.4 (a) Plane Polariscope (b) Circular Polariscope 

dialog boxes 

(b) 
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2.4. Visualization of fringe patterns in white light 

Many conventional polariscopes have usually dual light sources, one is the monochromatic source of 

Sodium vapour (589.6 nm) and the other is the white light source.  If one uses a white light source, 

the isochromatics would appear in colour.  Simulation of fringe patterns in colour is possible due to 

developments in white light photoelasticity namely Twelve Fringe Photoelasticity (TFP) [1].  Since it 

is only a theoretical simulation, up to twelve fringe orders can be plotted and beyond twelve fringes a 

uniform colour of red is put.  

1. One can view the simulated plot of isochromatics in white light by selecting Fringe 

patterns/PhaseMaps option from Pop-up Menu. 

2. Click Fringe patterns/PhaseMaps option from the main menu.  The Result viewer dialog box 

pops up (Fig. 1.5).  

3.  In the Result Viewer dialog box, various options for viewing the fringe patterns in colour (i.e., 

under a white light arrangement, etc.) are available.     

                              

 

4.  One can view the simulated fringe pattern under Plane Polariscope dark field, Circular 

Polariscope dark field and Circular Polariscope bright field.  

2.5. Visualization of whole field stress components 

P_Scope
®
 also has a facility to visualize the stress components as whole field colour maps. This can 

be accessed by clicking the 2
nd

 dropdown menu associated with Pop-up Menu called 'Stress 

Component Plots'. User can select a particular component from the list of components available. For 

Fig. 1.5 Fringe Patterns/PhaseMaps Pop-up Dialog 
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stress component in x direction (σx), it will appear as Fig. 1.6a. The default plot uses the maximum 

and minimum values of the data and in general it may not reflect the variation nicely (Fig. 1.6b). 

P_Scope
®
 can also plot stress components as pseudo fringe contours (Fig. 1.6c). Unlike in 

photoelasticity, the pseudo fringe contours can have negative fringe orders. The shape of the 

contour is easily noticed by plotting the pseudo fringe contours. To improve Fig. 1.6b, the user has to 

change the maximum and minimum values in the edit box and click 'Update Plot' so that it matches 

with the shape of the pseudo fringe contours (Fig. 1.6c). The maximum and minimum values of the 

contour plots need to be selected suitably by the user as they are problem dependent. The edited 

scale for this case is highlighted in Fig. 1.6a.  One can switch to other stress component plots by 

selecting appropriate options in the top right corner of the list available in the stress component Plot 

Menu.  

 

2.6. Generic polariscope arrangements 

Although, digital photoelasticity in white light can use simple conventional polariscope arrangements 

for data reduction, if monochromatic light source is used, different arrangements other than 

(a) 

(b) 

(c) 

Fig. 1.6 (a)Stress Component Plots - Pop-up Dialog (σx plot) with edited scale (b) stress component plot with 

un edited scale. (c) pseudo fringe contours for σx 

      Default Scale:    Max Value: 1.42 
                                 Min  Value: -228.47 
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conventional arrangements are needed. There are several arrangements reported in the literature.  

The appearance of intensity data over the model area can be easily simulated using the 'Generic' 

radio button in the Plane or Circular Polariscope dialog box (Fig. 1.4). 

1. When the polariser and analyzer are at the same angle one gets a bright field arrangement.  

2. Select generic radio button in the Plane Polariscope dialog box to change the position of the 

polariser and analyzer. 

3. One can choose the generic arrangement in Circular Polariscope dialog box and edit the 

orientation of optical elements to the desired arrangement of the polariscope.  

3. Exercises 

For the following exercise problems make a neat PowerPoint presentation of your results with the 

fringe patterns and also display the relevant default model parameters suitably.   

1. View the 20
o
 isoclinic in Plane Polariscope, dark and bright fields in Circular Polariscope for the 

following problems in both monochromatic and white light sources.  

A. Circular disc under diametral compression with model material as polycarbonate 

B. Ring under diametral compression 

C. Beam under pure bending 

D. Semi-infinite plane under horizontal concentrated load 

E. Semi-infinite plane under vertical concentrated load 

F. Plate with a hole under vertical load 

G. Plate with a hole under horizontal load 

H. Semi-infinite plane under concentrated load at an angle of 30
o
 

I. Semi-infinite plane under concentrated load at an angle of 45
o
 

J. Thick cylinder under internal pressure 

Note: The software offers multiple ways to save information (Fig. 1.7).  

'Save Image on View' option available in the File menu saves the image in the main view with the 

model name in the P_Scope_Images directory at any point in time. This is particularly useful when 

the user wants to save the image with an overlay of annotations such as fringe order and isoclinic 

angle etc. 

'Save Wave on View' saves the light wave propagation at a point in the model in the 

P_Scope_Images directory with a default file name modelname_wave. This helps the user to record 

the polarisation behaviour of any specific point in the model domain. 

Click Save Screen to File option in the File menu (Fig. 1.7) to save the complete screen. This would 

be of help when the user needs to save the different parameters or other information on the screen 

to be saved for future reference. On clicking 'Save Screen to File', the software prompts the user to 
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save the file with a default file name 'screen'. User can modify this name accordingly and is saved in 

P_Scope_Image directory.  

Apart from these options for saving the images, P_Scope
®
 also has a facility to save the image 

associated with each Pop-up Menu. This can be done by clicking the 'Save Image to File' button 

available in the 'Fringe patterns/PhaseMaps' and 'Stress Component Plots'. This would be of 

immense use routinely by the user.  

 

 

2. Select five different points on and off the fringe and summarise the light wave propagation in 20
o
 

isoclinic in Plane Polariscope, dark and bright fields of a Circular Polariscope.   

3. Investigate whether the following arrangement is dark field or bright field. The position (in 

degrees) of the polarizer, analyzer, first and second quarter wave plates are given below.  

Record the relevant fringe patterns with relevant parameters and submit them as part of your 

report.  

Setup Polarizer First QWP Second QWP Analyzer 

A. 90 135 0 45 

B. 90 135 45 180 

C. 90 135 90 135 

D. 90 135 135 180 

E. 90 135 180 135 

F. 90 45 0 135 

G. 90 45 45 90 

H. 90 45 90 45 

I. 90 45 135 180 

J. 90 45 180 135 

 

Fig. 1.7 Save Screen to File option 
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(ii) Lecture 17 - Circular Polariscope  

Link: https://youtu.be/NprJC_zFOLA 

   Demonstration on physical polariscope (starts at time 28.00) 

2. Quick appreciation of Photoelasticity : By Prof. K. Ramesh, IIT Madras. 

  Link: https://youtu.be/F9VDuiDPUEI 
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10. Understanding Stress Fields Using P_Scope® 

 

1. Objective 

To appreciate the stress component variation along selected lines or contours that help in  

understanding the stress fields. 

2. Nuances of Stress Field in Beam Problems 

One of the central aspects in developing stress fields in Strength of Materials is the basic 

assumption that plane sections remain plane before and after loading. Although, one could get 

solutions that are acceptable in engineering practice, the solution is not adequate from a mechanics 

point of view. The concept of neutral axis and plane sections remaining plane before and after 

loading hold good only for a beam of uniform cross section subjected to pure bending. Even for the 

simplest problem of a cantilever subjected to end load, plane sections before and after loading do 

not remain plane and not all stress components are zero at the neutral axis. As bending and shear 

are not coupled, simple beam theory is sufficient to predict the bending stress. Further, the value of 

shear stress for slender beams is so small (20 times less for rectangular cross section) in 

comparison to bending stress and hence their effects can be neglected.  

At a first level course in SM or Mechanics of Solids, one is trained to look at the variation of bending 

stress as linear and the shear stress as parabolic. In the process, the relative magnitudes are 

forgotten! P_Scope
®
 provides ample scope to appreciate the variation as well as the magnitudes to 

reinforce the learning better. It has a quick plot facility to appreciate the variation as a graph, which is 

plotted with a scale whose maximum value is dictated by the quantity plotted. Hence, the shape is 

quickly seen and the relative values can be appreciated by looking at the values in the axis. The 

software also offers a facility to dump the data to an Excel file. The students can be asked to plot 

bending and shear stress with the same scale to appreciate the relative magnitudes more forcefully. 

It is also worthwhile to plot the variation of various stress components along the centroidal axis of the 

cross section (neutral axis of the beam) for the cases of beam under pure bending, beam subjected 

to uniformly distributed load and the cantilever beam. One can be asked to comment on the results 

obtained and document the isochromatic fringe order values along these lines. 

One of the common doubts a student gets after completing the course is whether, a compressive 

stress exists for an uniformly distributed load in bending? Strength of materials ignores this stress, 

whereas Theory of Elasticity recognises this as the solution is obtained by solving the equilibrium 

equations. Though the value of compressive stress is small, it does exist to satisfy the equilibrium 

conditions and its variation can be plotted by P_Scope
®
 as one can switch between Theory of 

Elasticity and Strength of Materials solution. In addition, it would be a worthwhile exercise to find out 

the  variation of normal stress component (σxx) predicted by Theory of Elasticity and also by Strength 

of Materials. It is well documented in the literature that σxx stress component from Theory of 

Elasticity has a nonlinear part apart from simple beam theory result from Strength of Materials. 

Though this nonlinear term has a very small value, students can be asked to plot this using the 

feature of dumping data along a contour to Excel (Appendix A). 
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First level course also drives home the point that the shear stress variation over the depth of the 

beam is parabolic. But is it parabolic for all beams at all cross sections? How does a cross-section 

close to a load application point support the load? Such a knowledge becomes very important in 

designing beams as one has to put extra stiffeners near load application points to support excessive 

shear stress.  

This can be well illustrated in P_Scope
®
 by plotting the shear stress variation for the case of a three-

point-bent specimen closer to the load application point and away from it. The number of terms in 

the series solution can be changed to study its influence. 

3. Nuances of Stress Field in the Problem of an Infinite Plate with a Small Hole 

It is well discussed in the first level course that for an infinite plate with a small hole, the stress 

concentration factor is 3. How do the stress components vary over the boundary of the hole? Are 

there points where the stress tensor on the boundary is zero? Is there a possibility that the tangential 

stress component on the boundary be negative? This understanding becomes important as if one 

optimises the thickness indiscriminately, it can lead to local buckling which is a serious issue in 

fracture toughness testing of thin plates. Also, one should know how the value of stress 

concentration depends on the type of loading such as uniaxial, tension-tension or tension-

compression. All these aspects can be well illustrated using P_Scope
®
.  

P_Scope
®
 has a special feature to plot data along user specified contours such as a circle. A circle 

can be drawn over the hole boundary and the data for any of the stress components can be plotted 

and also dumped to the excel file. Look at the isochromatic fringe features for uniaxial, tension-

tension, tension-compression, and compression-compression. Do you find similarity between any of 

these fringe patterns with any of the problems that P_Scope
®
 can solve? 

4. Nuances of Stress Field in the Problem of a Thick Ring Subjected to Internal Pressure 

For any radial line, P_Scope
®
 can be used to plot all the stress components and the same can be 

done for circle of any radius too! This would help to appreciate the variation of stress components 

along these directions. In addition, one can also change the inner and outer radii of the thick ring to 

see the variation of stress components along radial and tangential directions. 

5. Nuances of Stress Field in the Problem of a semi- Infinite Plate subjected to an arbitrary 

concentrated load 

It is well documented that the stress field in this case is a simple radial distribution. This can be well 

brought out by plotting the stress components along circles that touch the plate boundary at the point 

of loading. Only the radial stress component would exist and all other components would be zero. 

What is the level of this stress when a large circle is reduced to a small one? Plot and see for 

yourself.
 

6. Nuances of Stress Field in the Problem of a Circular Disc Under Diametral Compression 

The solution to this problem is obtained by suitably superimposing the solution to the problems of 

semi-infinite plate along with the Lame’s problem. A disc is culled out from the semi-infinite plate and 

the boundary of the circle is made free by removing the loads by Lame’s problem. The previous 
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exercise on plotting stress components along a circle touching the point of loading of the semi-

infinite plate gives a clue as to what stress components exists on this surface.  

It is a benchmark problem used in photoelasticity as the model is easy to machine and easy to load. 

Stress components along various lines of interest can be plotted by using P_Scope
®
. 

7. Nuances of Stress Field in the problem of a Ring Under Diametral Compression 

This is again a benchmark problem in photoelasticity. Solution to this has been used for designing 

tunnels in some sense. Variations of stress components on the inner and outer boundaries share 

some common features to the boundary of the hole in an infinite plate. The stress components along 

inner and outer boundary can be easily potted using P_Scope
®
.  Further, the problem has many 

isotropic points in the domain. Draw a small circle around these and assess the nature of stress field 

by plotting the various stress components. Can you remove material at these points to reduce 

weight? Comment on your results.  

8. Nuances of Stress Field in Contact Problems 

One of the key learning in contact problems is that the maximum shear stress occurs beneath the 

surface in Hertzian contact. This is best seen by simulating isochromatics in which the maximum 

fringe order indicating a high level of maximum shear stress is seen as an eye below the surface. 

This explains pitting failure seen in gears and other contacting surfaces like rails, cams etc. If friction 

is present between the contacting bodies then this eye is pulled to the surface and in such a case 

the surface can have the highest value of the maximum shear stress. 

One can also use P_Scope
®
 to plot variation of stress components along different lines of interest. 

9. Nuances of Stress Field in Crack  Problems 

It is characterised by the fact that stresses have a steep stress gradient towards the crack-tip and  

reach infinity (in Westergaard's solution) at the crack tip. This can be easily illustrated, by plotting the 

stress components on various radial lines selected.  

While deriving the Westergaard's crack-tip stress field solution, the boundary conditions used are too 

restrictive that while imposing, shear stress zero condition along the crack axis ahead of the crack 

also forces the maximum shear stress to be zero. This observation led Sanford to develop 

Generalised Westergaard equations which is found to be equivalent to Williams series solution. 

It is instructive to plot the variation of shear stress and maximum shear stress (variation of 

isochromatic fringe order) for the line along the crack axis for various number of terms of the series 

solution available in P_Scope
®
. 

10. Closure  

 

In all these problems, one can demonstrate that change of materials does not affect the stress field 

and the principal stress directions are not altered for a given problem if the loads are changed. For 

general reading one can listen to the following NPTEL Lectures: 

 

1. Optical Methods Work as Optical Computers: https://youtu.be/IIpu_rOrs4E 

https://youtu.be/IIpu_rOrs4E
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2. Stress Strain and Displacement Fields: https://youtu.be/r8KzP7G7Uks 

3. Review of Theory of Elasticity. https://youtu.be/FEgp3o-8X6c  

 

 

 

 

 

 

 

 

  

https://youtu.be/r8KzP7G7Uks
https://youtu.be/FEgp3o-8X6c
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Appendix A: Plotting and Exporting Data along Contours In P_Scope® 

 
1 Accessing Plotting Module  

The plotting module can be activated once the user selects a model. As given in previous 

experiments, P_Scope
®
 has Pop-up Menus for Fringe Pattern Plots and Stress Component Plots. 

These menus essentially present whole field plots. In many situations user would like to know the 

variation of stress components along specified contours in the model. To illustrate the basic 

capabilities of contour plotting scheme, different example problems are used. Whole field Stress 

component in x direction (σxx) for disc under diametral compression is shown in Fig. A.1. Clicking on 

'Export Plot Data', opens the child window titled Plotter (Fig. A.2a). 

 

Fig. A.1  Stress Component (σxx) plot for Disc under Diametral compression  
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The plotting module has facilities to plot along a line of interest or user specified contours. Plotting 

data along any specific line is directly available from the plotter dialog box. If the user wants to plot 

data along any user defined contour, one can select an arbitrary contour and it opens up a new child 

dialog (Fig. A.2b). Currently, it can export data for rectangle or circular contours selected by the 

user. Though these are opened in different dialogs, these are nested in nature and the child dialog 

can communicate and pass data to parent dialog internally. This is done to keep the GUI simple and 

this kind of nesting provides ease in the selection of different options available with the plotter. 

Important Note: User has to make a note that the 'Stress Component Information' dialog and 

labelling of data by clicking on 'Popup menu' is inactive while the plotter dialog is opened. 

One can close the plotter and access the information in 'Stress Component Information' 

dialog and label the data on the Popup image. 

2. Plotting Data and Exporting Data 

2.1.1  Plotting Data Along any Arbitrary Line 

Press 'Select Points & Draw Line' button located in the plotter menu (Fig. A.3a) and select the points 

on the image. If 'Show Line' radio button is active, the line gets displayed on the image (Fig. A.3b). 

User can also edit the pixel values in the entry boxes marked as X1, Y1, X2, Y2 by changing the 

start and end points of the line suitably. For example, if one wants an exact horizontal line, make 

sure that Y1 and Y2 are identical. Similarly, make sure that X1 and X2 are identical for a vertical line. 

On similar lines, lines at any angle can be plotted by editing this suitably. On clicking 'Plot Data', the 

line plot is displayed in a separate dialog as shown in Fig. A.3c. Please note that it is a simple facility 

to get a feel of the variation of the quantity plotted. Scaling is done automatically and the data points 

along x-axis are in pixels. The user has to interpret the unit appropriately depending on the context. 

Stresses are reported in MPa and fringe orders are just numbers. Scaling is dictated by the 

maximum value and the shape of variation is beautifully captured by this feature. To see the relative 

magnitudes, one should look at the data values. For example, in beam problems, shape of variation 

Fig. A.2 (a) Parent dialog for Export Plot Data (b) Child dialog for plot along user specified 
contours 

 
(b) (a) 
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of normal stress and shear stress is very important. However, the values of shear stress are quite 

small which can be assessed by looking at the data value.  

 

2.1.2 Plotting data for another component for the same line 

If the user wants to plot different data along the same line, one just needs to select the appropriate 

option from the Pop-up Menu and click on 'Plot Data' button in the plotter dialog. (Please note: The 

plotter dialog should not be closed to select various plots. The drawn plot line will vanish if closed). 

An example is given here by selecting stress component in y direction (σyy) from the option available 

(a) (b) 

(c) 

Fig. A.3 (a) Select and plot line parameter box in plotter menu (b) Selected line plotted on the σxx map 
(c) Variation of σxx stress along the line shown in (b).  
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on top right corner in the Pop-up Menu (Fig. A.4a). The corresponding variation of σyy is plotted 

along the line and is shown in Fig. A.4b.   

 

User can also dump the data into an excel file. This can be done by clicking 'Create' tab and specify 

the file name in which the data needs to be saved (Fig. A.4c). Clicking on 'Add Line To File' will save 

the plotted data into the particular excel file (Note: This button needs to be pressed for the very first 

line of data too). Data along different lines can be appended to the same excel file. After selecting 

and plotting data for another line, clicking 'Add Line To File' appends this data in the excel file. 

Repeat the same procedure for other lines. 

2.1.3 Plotting for the same line for change of parameter and zoom 

Suppose one wants to change model parameters and wants to compare the data for the same line 

of interest, follow the steps given below.  

1) Do not close the plotter dialog 

2) Go to parameters dialog (Setup menu) and change the desired parameter 

3) The image in view as well as stress component plot will change 

(a) (b) 

(c) 

Fig. A.4 (a) Whole field plot of σyy stress component (b) Plot for σyy data along the same line shown 
in Figs. A.3 (a). (c) Option for dumping data into an Excel file 
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4) To effect data transfer to the line of interest, just click the bar cursor. This action triggers data 

transfer. Press 'Plot Data' to plot the current stress component. For plotting different stress 

component, select the components of interest and then press 'Plot Data'.  

Suppose one wants to zoom the image and plot data, then follow the above steps. (Note: Particularly 

pay attention to step 4 to trigger data transfer for the particular configuration of the problem). 

2.2 Plotting Data along Arbitrary Contour 

P_Scope
®
 also has a facility to plot data along user defined contour. To access this, user needs to 

click the 'Select Plot data along User-Specified Contours' (Fig. A.5a). Clicking this opens up a child 

dialog associated with this having different drawing primitives (Fig. A.5b). Initially, plotting along a 

rectangular boundary is presented. Beam under pure bending is used to illustrate this and σxx stress 

component is plotted (Fig. A.5c) using Pop-up Menu of P_Scope
®
. 

 

One can follow the given steps to plot the data along a rectangular boundary. 

 Select the radio button corresponds to 'Rectangle'. Then press 'Draw Contour' and select the 

left and right corner of the rectangle on the image. This shows the boundary on the image in 

green (Fig. A.5c). 

 When a closed contour is selected, user has the facility to select the starting point of the plot. 

User needs to specify the starting point by clicking 'Select start point'. Here the midpoint of the 

top line of the rectangle is selected (Fig. A.5c). 

(a) 

(b) 

(c) (d) 

Fig. A.5 (a) Option for user specified contour plot (b) Child dialog for user specified contour plot (c) 
rectangle boundary with starting point to trace indicated with sense of tracing (Anticlockwise) (d) 
Plot for stress component in x direction along the rectangular contour. 
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 Once the seed point is selected, the user has no control on which way the data will be dumped 

for plotting. This is internally done by a tracing algorithm. The data can be traced either 

clockwise or anticlockwise dictated by the type of contour and the location of the start point. The 

direction of tracing can be identified by moving the slider bar, by which the tracing progress can 

be identified which is to be used to interpret the plotted graph. Here the trace is found to be in 

an anticlockwise manner.  

 Once the contour is traced, one can plot the data along the contour by clicking 'Plot data along 

Contour'. This plots the data as shown in Fig. A.5d. It is to be understood that the data plotted is 

starting from the start point along the contour in the direction of the sense of tracing. Hence, in 

this case, it is plotted from the seed point in anticlockwise manner along the rectangular 

boundary. 

 

(a)(

(a) 

Fig. A.6 (a) Variation of tangential component of stress in plate with a hole subjected to tension. (b) 
Variation of tangential stress component along the contour shown in (a). (c)  Variation of radial 
component of stress in plate with a hole subjected to tension. (d) Variation of radial stress 
component along the contour shown in (a). 

(c) 

 

(b) 

(d) 



65 
 

                    
Copyright © 2017, Prof. K. Ramesh, IIT Madras 

Similarly, plotting along a circle is illustrated with the help of plate with a hole problem. Stress 

component tangential to the boundary (σθθ) plotted from Pop-up Menu is shown in Fig. A.6a. User 

needs to select the radio button Circle and press 'Draw Contour' for drawing the contour. One has to 

select three points along the circumference of the circle to draw the circle. Follow the steps 

mentioned previously and proceed for selecting a start point followed by tracing. Here, this is traced 

in clockwise sense and the plot for the σθθ is shown in Fig. A.6b. Following steps of Sec. 2.1.2, radial 

stress component (σrr) can be plotted for the same contour by selecting the 'SigmaX/SigmaR' option 

from the Pop-up Menu. Radial stress component will be displayed as shown in Fig. A.6c. Clicking 

the 'Plot Data Along Boundary' button displays the variation of radial stress component along the 

circle contour as shown in Fig. A.6d.  

The plot indicates that σθθ  and σrr varies from tensile to compressive and takes zero values at four 

points on the circumference. However, the magnitudes of radial stress components are much lower 

when compared to that of the tangential stress component. Suppose the circle drawn exactly 

matches with the hole, can you expect points at which stress tensor is zero? Think and experiment 

about it. For plotting along the same contour for different model parameters or zoom option, follow 

the recommendations in Sec. 2.1.3. 

Reference 

1. NPTEL Lectures on Engineering Fracture Mechanics by Prof. K. Ramesh, IIT 

Madras.Discussion on "Stress concentration at a circular hole". In Lecture 14, Forms of 

Stress Function. https://youtu.be/FNZv-aMTr4A 

  

https://youtu.be/FNZv-aMTr4A


66 
 

                    
Copyright © 2017, Prof. K. Ramesh, IIT Madras 

  



67 
 

                    
Copyright © 2017, Prof. K. Ramesh, IIT Madras 

11. Plotting of Photoelastic Fringe Contours from Finite Element 

Results in ABAQUS 

 
Background  

In photoelasticity, the fringe contours observed in the experiment are related to the principal stresses 

in the body by the stress-optic law which is defined as, 

 

 

where σ1 and σ2 are the maximum and minimum principal stresses, N is the fringe order, Fσ is the 

material stress fringe value and t is the thickness.  

Although finite element (FE) analysis is good for parametric study, at least for one configuration, the 

FE modelling needs to be verified. This is done by comparing the results with one of the 

experimental techniques. If the comparison is to be made with photoelasticity, instead of comparing 

the stress components, it is prudent to generate photoelastic fringe patterns from FE results. None of 

the standard packages provide such a facility. The fringe contours for FE results should be plotted 

using the same colour spectrum as observed in photoelasticity. This document explains the 

procedure to plot photoelastic fringe patterns by post-processing results from ABAQUS.       

1. Objective 

Define fringe order, N and photoelastic colour spectrums in ABAQUS. Use the post processing tools 

of ABAQUS to plot photoelastic fringe contours for benchmark problems.  

2. Required Files 

An ODB file having the results of the FE analysis.   

 

3. Plotting Photoelastic Contours in ABAQUS  

Open the OBD file of the FE analysis for which photoelastic contours are to be plotted. Figure 11.1 

shows the GUI of the menu associated with ABAQUS software. 

 

Fig. 11.1 ABAQUS menu 

3.1. Define Fringe Order 

To define fringe order (N); select ‘Create Field Output – From Fields’ option in the ‘Tools’ menu. Now 

using the stress-optic law, define the parameter, N by using the variables and mathematical 

operators available in the pop-up window as shown in Fig. 11.2. The newly defined fringe order, N is 

stored in the ‘Session Step’ which can be accessed by clicking on the ‘Step/Frame’ option in the 

‘Result’ menu. 

1 2

NF

t
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Fig. 11.2 Create Field Output dialog box 

3.2. Create Colour Spectrum Corresponding to the Photoelastic Fringes 

A new colour spectrum which has been extracted from the calibration table of the experimental 

photoelastic fringe contours needs to be created in ABAQUS. In white light photoelasticity, colour 

calibration tables are available for up to twelve fringes. A colour spectrum can also be created for 

monochromatic (grey scale) photoelastic fringes. Here, the step-by-step procedure to create the 

colour spectrum for three fringes in photoelasticity is described. The same procedure can be used to 

create other colour spectrums. 

In ABAQUS, any new colour spectrum created will be available for use only in that session. To avail 

the colour spectrum permanently, the procedure should be saved as a ‘macro’ file.  

In the ‘File’ menu, select the ‘Macro Manager’ option. A macro manager window, shown in Fig. 11.3 

pops-up which can be used to create new and also to access existing macro files. Click on ‘create’ 

option to create a new macro file. Name the macro file and specify the directory and continue to 

begin recording. During the recording process, any command given to ABAQUS via. GUI will be 

saved in the macro file.  

Once the recording has begun, select ‘create’ from the ‘Spectrum’ option in the ‘Tools’ menu. A 

‘Create Spectrum’ window as shown in Fig. 11.4a pops-up. First, delete the existing colours and 

then add colours to the new spectrum by clicking on ‘Insert Before’ which opens a ‘Select Colour’ 

window as shown in Fig. 11.4b. In this, the required colour can be chosen by changing the ‘Red (R)’, 

‘Green (G)’ and ‘Blue (B)’ colour values.  

The fringe order values and their corresponding RGB values for colour spectrum is listed in 

Appendix - B. Table 11.1 lists the fringe order and the corresponding RGB values for three fringes in 

photoelasticity. Once all the colours are added and the spectrum is created, click on ‘Stop 

Fig. 11.3 Macro Manager dialog box 
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Recording’ in the ‘Record Macro’ pop-up window. The macro file thus created can be accessed in 

the ‘abaqusMacros.py’ file in the directory in which the macro is created.  

                   

(a) (b) 

Fig. 11.4 (a) Create Spectrum pop up menu (b) Select Colour pop up menu 

3.3. Plotting the Photoelastic Fringes in ABAQUS 

Choose the photoelastic fringe colour spectrum from the ‘Spectrum’ list available on the left side of 

the ABAQUS GUI as shown in Fig. 11.5a. Now, click ‘Contour’ option in the ‘Options’ menu. A 

‘Contour Plot Options’ window pops-up as shown in Fig. 11.5b. In the ‘Basic’ section, choose the 

‘Contour Intervals’ to be ‘Discrete’ with Interval type as ‘User Defined’. By clicking on the pencil 

shaped button below the ‘interval type’ option a pop-up window opens as shown in Fig. 11.5c. In this 

window, provide the fringe order values to the corresponding colours as shown in Fig. 11.5c.  

            

                    (a)                                                        (b)                                                 (c) 

Fig. 11.5 (a) Spectrum list in ABAQUS (b) Contour Plot Options pop up menu (c) Edit Intervals pop up 

menu 
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(a) (b) 

Fig. 11.6 (a) Colour & Style menu (b) Limits menu in Contour Plot Options pop up menu 

In the ‘Colour & Style’ section of the ‘Contour Plot Options’, specify red colour to be used for any 

values greater than maximum (i.e. N = 3 in this example) as shown in Fig. 11.6a. In the ‘Limits’ 

section, specify the maximum and minimum value to be 3 and 0 respectively as shown in Fig. 11.6b. 

Now, go back to ‘Basic’ section and select the ‘Continuous’ radio button to plot the photoelastic 

fringe contours in ABAQUS. Fig 11.7 and 11.8 show photoelastic fringe contours for a few standard 

specimens. 
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(a) 

(b) 

Fig. 11.7 Photoelastic fringe contours in (a) Circular Disc (b) Spanner plotted using three fringe colour 

spectrum 
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Reference 

1. NPTEL Lectures on Experimental Stress Analysis by Prof. K. Ramesh, IIT Madras: 

Discussion on "Completeness of a numerical solution - Spanner Tightening a nut". In Lecture 

4. https://youtu.be/kzWbdP5gqb0 

 

 

(b) 

Fig. 11.8 Photoelastic fringe contours plotted using twelve fringe colour spectrum in (a) plate with a 
hole specimen (b) Ring under diametral compression 

(a) 

https://youtu.be/kzWbdP5gqb0
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Appendix - B 

Table B.1 List of fringe order and their corresponding RGB values for three fringe photoelasticity 

Three Fringe Colour Spectrum 

Fringe Order (N) 
Decimal 
(R, G, B) 

Hexadecimal 

0 21,31,22 #151F16 

0.1 35,51,29 #23331D 

0.2 63,93,75 #3F5D4B 

0.3 98,144,112 #629070 

0.4 132,185,129 #84B981 

0.5 154,200,117 #9AC875 

0.6 156,182,80 #9CB650 

0.7 140,141,42 #8C8D2A 

0.8 107,84,19 #6B5413 

0.9 67,39,27 #43271B 

1 43,25,49 #2B1931 

1.1 29,74,104 #1D4A68 

1.2 40,119,109 #28776D 

1.3 66,163,90 #42A35A 

1.4 101,91,160 #655BA0 

1.5 136,192,32 #88C020 

1.6 162,165,25 #A2A519 

1.7 167,112,43 #A7702B 

1.8 150,65,70 #964146 

1.9 121,39,88 #792758 

2 103,35,90 #67235A 

2.1 34,98,59 #22623B 

2.2 26,144,38 #1A9026 

2.3 39,172,33 #27AC21 

2.4 71,178,45 #47B22D 

2.5 111,153,65 #6F9941 

2.6 142,116,76 #8E744C 

2.7 160,75,75 #A04B4B 

2.8 158,62,63 #9E3E3F 

2.9 146,48,53 #923035 

3 143,48,52 #8F3034 

Lower Limit 0 

Upper Limit 3 

Colour below lower limit 0,0,0 #000000 

Colour above upper limit 255,0,0 #FF0000 
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